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ual describes detailed instructions on the operation and notes about the use of this machine
aximum versatility from this machine all operators are requested to read this manual carefully
w the instructions. Please keep this manual in a handy place near the machine.

t

 of this manual are subject to change without prior notice. In no event will the company be
 direct, indirect, special, incidental, or consequential damages as a result of handling or oper-
machine.

rks

t®, Windows® and Windows NT® are registered trademarks of Microsoft Corporation in the
ates and/or other countries.
nd PostScript® are registered trademarks of Adobe Systems Incorporated.
h, Mac OS, Apple, AppleTalk, EtherTalk, LaserWriter are registered trademarks of Apple
r, Inc.
duct names used herein are for identification purposes only and might be trademarks of their
e companies. We disclaim any and all rights in those marks.
er names of the Windows operating systems are as follows:
roduct name of Windows® 95 is Microsoft® Windows 95.
roduct name of Windows® 98 is Microsoft® Windows 98.
roduct name of Windows® Me is Microsoft® Windows Millennium Edition (Windows Me).
roduct names of Windows® 2000 are as follows:
soft® Windows® 2000 Advanced Server
soft® Windows® 2000 Server
soft® Windows® 2000 Professional
roduct names of Windows® XP are as follows:
soft® Windows® XP Professional
soft® Windows® XP Home Edition
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Notes:

Certain 
product names of Windows ServerTM 2003 are as follows:
osoft® Windows ServerTM 2003 Standard Edition
osoft® Windows ServerTM 2003 Enterprise Edition
osoft® Windows ServerTM 2003 Web Edition
product names of Windows NT® 4.0 are as follows:
osoft® Windows NT® Server 4.0
osoft® Windows NT® Workstation 4.0

options might not be available in some countries. For details, please contact your local dealer.
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g up Options

mentation describes the specific printer functions and menus that are added by installing the
For more information about the functions and menus of the Windows 95/98/Me PostScript

iver, see the printer driver's Help.

ration
acintosh, Mac OS 8.6 or later (Mac OS X Classic environment is supported.) or Mac OS X

r later is required.

tion
use Mac OS X, the following functions cannot be used:

ple Print

ked Print

r Code

S X” in the tables below refers to Mac OS X 10.2.3. Depending on the version, [Features x]
layed as [Set x] (x is a number). Make adjustments according to the version you use.
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 to select the type of print job.

owing table shows the tabs or menus where you can select this function.

 select the following items:

al
ct this for normal printing. The print job starts immediately after the print command is given.

ote
nder Windows 95/98/Me, if you want to use an User ID, click the [Detail] button.

ple Print
this function to print only one set of a multiple print jobs.
other sets are saved in the machine. The saved job can be printed from the machine's control
l. You can also delete the saved job.

imitation
o use this function, the optional Hard Disk Drive must be installed on the printer.

s 95/ 98/ Me [Job Type] on the [Setup] tab.

s 2000/XP, Windows Server 2003 [Job Type] on the [Job Log] tab in the Printing Preferences dialog box.

s NT 4. 0 [Job Type] on the [Job Log] tab in the Document Defaults dialog box.

[Job Type] on [Job Log] in the print dialog box.

 X This function is not available.



7

N
❒ T

❒ E

R
F

❖❖❖❖ Lock
Use 
them

L
❒ T

N
❒ T

m

R
F

ote
he “User ID” can consist of up to eight alphanumeric (a- z, A- Z, 0- 9) characters.

ntering the “User ID” helps you to distinguish the print job from others.

eference
or more information about how to use Sample Print, see p.8 “How to Use Sample Print”.

ed Print
this function to save documents in the machine memory with a password, and then edit and print
 as you want.

imitation
o use this function, the optional Hard Disk Drive must be installed on the printer.

ote
he “User ID” can consist of up to eight alphanumeric (a-z, A-Z, 0-9) characters. The “Password”
ust be four digits.

eference
or more information about how to use Locked Print, see p.11 “How to Use Locked Print”.
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Use Sample Print 

the procedures to print a document using the “Sample Print” function.

 application has a collate option, make sure that it is not selected before sending a print job. By
ult, sample print jobs are automatically collated by the printer driver. If the collate option is se-
d in the application print dialog box, more prints than intended may be printed.

ws 95/98/Me

 an application, select the menu command to print.

print dialog box appears.

n the Printer Properties to set Sample Print.

k to select the [Setup] tab.

ct [Sample Print] in [Job Type].

k [Details...].

r the “User ID” in [User ID]. This can consist of up to eight alphanumeric (a- z, A- Z, 0- 9)
acters.

ote
elect this to identify the user associated with the job.

k [OK].
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 an application, select the menu command to print.

print dialog box appears.

n the Printer Properties to set Sample Print.

k to select the [Job Log] tab.

ct [Sample Print] in [Print Job].

r the “User ID” in [User ID]. This can consist of up to eight alphanumeric (a- z, A- Z, 0- 9)
acters.

ote
elect this to identify the user associated with the job.

k [OK] to close the Printer Properties.

t printing from the application's print dialog box.

Sample Print job is sent to the machine and one set is printed.

ck the sample print to confirm that the settings are correct.

 settings are correct, see “Printing the Remaining Sets”, Client Reference.

t, you can delete the saved job. See “Deleting a Sample Print File”, Client Reference.
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 an application, select the menu command to print.

print dialog box appears.

k to select [Job Log] from the pop up menu.

ct [Sample Print] in [Job Type], and then select the appropriate setting.

r the “User ID” in [User ID]. This can consist of up to eight alphanumeric (a-z, A-Z, 0-9)
acters. 

ote
his is used to identify the user associated with a job.

he “User ID” can consist of up to eight alphanumeric (a-z, A-Z, 0-9) characters.

r making all of the settings you want, click [Print].
Sample Print job is sent to the machine and one set is printed.

ck the sample print to confirm that the settings are correct.

 settings are correct, see “Printing the Remaining Sets”, Client Reference.

t, you can delete the saved job. See “Deleting a Sample Print File”, Client Reference.
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the procedures to print a document using the “Locked Print” function.

 application has a collate option, make sure that it is not selected before sending a print job. By
ult, locked print jobs are automatically collated by the printer driver. If the collate option is se-
d in the application print dialog box, more prints than intended may be printed.

ws 95/98/Me

 an application, select the menu command to print.

print dialog box appears.

n the Printer Properties to set Locked Print.

k to select the [Setup] tab.

ct [Locked Print] in [Job Type].

k [Details...].

r the “User ID” in [User ID]. This can consist of up to eight alphanumeric (a-z, A-Z, 0-9)
acters. Then enter a password in [Password], up to four digits.

ote
elect this to identify the user associated with the job.

k [OK].
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 an application, select the menu command to print.

print dialog box appears.

n the Printer Properties to set Locked Print.

k to select the [Job Log] tab.

ct [Locked Print] in [Print Job].

r the “User ID” in [User ID]. This can consist of up to eight alphanumeric (a-z, A-Z, 0-9)
acters. Then enter a password in [Password], up to four digits.

ote
se this to identify the user associated with the job.

k [OK] to close the Printer Properties.

t printing from the application's print dialog box.

Locked Print job is sent to the machine.

S

 an application, select the menu command to print.

print dialog box appears.

k to select [Job Log] from the pop up menu.

ct [Locked Print] in [Job Type], and then select the appropriate setting.
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r the “User ID” in [User ID]. This can consist of up to eight alphanumeric (a-z, A-Z, 0-9)
acters. Then enter a password in [Password], up to four digits.

ote
his is used to identify the user associated with a job.

e

 function to enable collation. With this feature, the printer can efficiently print collated sets of
-page documents.

itation
se this function, a Memory Unit of at least 192 MB or Hard Disk Drive must be installed on the
er.

u use Windows 2000, Windows XP, Mac OS or Mac OS X, make sure that the following check
s have not been selected.

indows 2000
he [Collated] check box on [Printer Features] on [Advanced...] on the [Paper/ Quality] tab in the
rinting Preferences dialog box.

indows XP
he [Collated] check box on [Paper/Output] on [Advanced...] on the [Paper/ Quality] tab in the
rinting Preferences dialog box.

ac OS
he [Collate] check box in the print dialog box.

ac OS X
he [Collate] check box on [Copies & Pages] in the printer dialog box.
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Mac OS
owing table shows the tabs or menus where you can select this function.

x Printing

 function to select duplex printing.

itation
se this function, the optional Duplex Unit must be installed on the printer.

cannot perform duplex printing from the Bypass Tray.

owing table shows the tabs or menus where you can select this function.

s 95/98/Me The [Setup] tab.

s 2000, Windows XP [Collate] on [Printer Features] on [Advanced...] on the [Paper/Quality] 
tab in the Printing Preferences dialog box.

s NT 4.0 [Collate] on [Document Options] on the [Advanced] tab in the Docu-
ment Defaults dialog box.

[Collate:] on [Printer Specific Options] in the print dialog box.

 X [Collate] on the [Feture 1] tab on [Printer Feature] in the printer dialog 
box.

s 95/98/Me [Duplex] on the [Setup] tab.

s 2000/XP, Windows Server 2003 [Print on Both Sides (Duplex)] on the [Layout] tab in the Printing Pref-
erences dialog box.

s NT 4.0 [Print on Both Sides (Duplex Printing)] on the [Page Setup] tab in the 
Document Defaults dialog box.

[Print on Both Sides] on [Layout] in the print dialog box.

 X The [Print on both Sides] check box on [Duplex] in the print dialog 
box.
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Print

❖❖❖❖ Flip 
Print
 select the following items: The following items may vary depending on the operating system
using.

s 95/98/Me

bles Duplex Printing.

n to Left
s output so that you can open it to the left.

n to Top
s output so that you can open it to the top.

s 2000/XP, Windows Server 2003, Mac OS, Mac OS X

u use a Mac OS, click to select the button that means [Flip on Long Edge] or [Flip on Short Edge].

e
bles Duplex Printing.

on Short Edge
s output so that you can open it to the short edge when bound along the short edge.

on Long Edge
s output so that you can open it to the long edge when bound along the long edge.
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Mac OS
s NT 4.0

e
bles Duplex Printing.

t Side
s output so that you can open it to the short edge when bound along the short edge.

 Side
s output so that you can open it to the long edge when bound along the long edge.

 Mode

 to select whether the document is printed in color or black and white.

owing table shows the tabs or menus where you can select this function.

u use Windows 95/98/Me, this mode is called “Color/Black and White”.

s 95/98/Me [Color/Black and White] on the [Setup] tab.

s 2000/XP, Windows Server 2003 [Color Mode] on [Printer Features] on [Advanced...] on the [Pa-
per/Quality] tab in the Printing Preferences dialog box.

s NT 4.0 [Color Mode] on [Document Options] on the [Advanced] tab in the 
Document Defaults dialog box.

[Color Mode:] on [Printer Specific Options] in the print dialog box.

 X [Color Mode] on the [Features 1] tab on [Printer Features] in the print 
dialog box.
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For m
 select the following items:

r
s color documents in full color.

ote
olor images will be printed using CMYK toner, Cyan, Magenta, Yellow and Black. CMYK are
ree primary subtractive colors.

 you want to adjust the print color, adjust the settings in the Advanced dialog box accessed from
e Advanced button on the [Paper/Quality] tab.

k and White
s everything, including color documents, in black and white. Black and White printing is faster
 Color printing. To stop black and white areas being printed with CMYK toner, select [Black

hite] in the printer driver as well as in the application.

 Selection

es and Destination Tabs

 to select the media type and input tray.

itation
 function is for Windows 95/98/Me only.

rence
ore information about the [All Pages and Destination] tabs. See the printer driver's Help.
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 to select the size of paper you want to use.

owing table shows the tabs or menus where you can select this function.

rence
ore information about the paper sizes supported by this printer, see “Paper and Other Media
orted by This Printer”, Maintenance Guide.

s 95/98/Me [Size:] on the [Paper] tab.

s 2000/XP, Windows Server 2003 [Paper Size:] on [Paper/Output] on [Advanced...] on the [Paper/Quali-
ty] tab in the Printing Preference dialog box.

s NT 4.0 [Paper Size:] on the [Page Setup] tab in the Document Defaults dialog 
box.

[Paper:] on the [Page Attributes] tab in the Page Setup dialog box.

 X [Paper Size:] in the Page Setup dialog box.
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e size of the document and paper size differ, set whether or not to print according to paper size

pt User
 is performed with the size of document to be printed unchanged.

est Size and Scale
 paper size is smaller than the selected papersize, the driver reduces the print size.
 paper size is larger than the size of document to be printed, print is not to fit the paper size.

est Size and Crop
n the paper size is smaller than the size of document to be printed, print is adjusted to meet the
r size.

s 95/98/Me [Fit to Print Size] on the [Paper] tab.

s 2000/XP, Windows Server 2003 [Fit to Paper] on [Printer Features] on [Advanced...] on the [Pa-
per/Quality] tab in the Printing Preferences dialog box.

s NT 4.0 [Fit to Paper] on [Document Options] on the [Advanced] tab in the 
Document Defaults dialog box.

[Gradation:] on [Printer Specific Options] in the print dialog box.

 X [Fit to Paper:] on the [Features 1] tab on [Printer Features] in the print 
dialog box.



20

Media

Use this

The foll

Refe
For m
Med

Window

Window

Window

Mac OS

Mac OS
 Type

 to select the paper type.

owing table shows the tabs or menus where you can select this function.

rence
ore information about the media type supported by this printer, see “Types of Paper and Other

ia”, Maintenance Guide.

s 95/98/Me [Type:] on [All Pages] on the [Paper] tab.

s 2000/XP, Windows Server 2003 [Media:] on the [Paper/Quality] tab in the Printing Preference dialog 
box.

s NT 4.0 [Paper/Output] on the [Advanced] tab in the Document Defaults dialog 
box.

[Paper Type:] on [Printer Specific Options] in the print dialog box.

 X [Paper Type] on the [Features 3] tab on [Printer Features] in the print 
dialog box.
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 to select the paper sources.

owing table shows the tabs or menus where you can select this function.

ution

 to set the resolution to [600 dpi].
owing table shows the tabs or menus where you can select this function.

s 95/98/Me [Input Tray:] on [All Pages] on the [Paper] tab.

s 2000/XP, Windows Server 2003 [Paper Source:] on the [Paper/Quality] tab in the Printing Preferences 
dialog box.

s NT 4.0 The [Page Setup] tab in the Document Defaults dialog box.

[Paper Source:] on [General] in the print dialog box.

 X [Paper Feed] in the print dialog box.

s 95/98/Me This function is not available.

s 2000/XP, Windows Server 2003 This function is not available.

s NT 4.0 [Graphic] on [Document Options] on the [Advanced] tab 
in the Document Defaults dialog box.

This function is not available.

 X This function is not available.
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 to select a type of gradation based on your purpose.

owing table shows the tabs or menus where you can select this function.

 select the following items:

dard
s with good quality of gradation.

s quickly while gradation loses some smoothness.

s 95/98/Me [Print Quality] tab.

s 2000/XP, Windows Server 2003 [Gradation] on [Printer Features] on [Advanced...] on the [Paper/Qual-
ity] tab in the Printing Preferences dialog box.

s NT 4.0 [Gradation] on [Document Options] on the [Advanced] tab in the Doc-
ument Defaults dialog box.

[Gradation:] on [Printer Specific Options] in the print dialog box.

 X [Gradation] on the [Features 1] tab on [Printer Features] in the print di-
alog box.
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 to select the color profile pattern.

owing table shows the tabs or menus where you can select this function.

 select the following items:

ortant
u use Windows 95/98/Me, you can configure [Color Profile] in [Advanced] by selecting [Manual]
 the[Color] setting. [Automatic] sets the printer to “Auto”.

this setting to configure the best color profile pattern automatically depending on the appear-
 of the document to be printed.

ographic
this setting to enhance the reproduction of photos and graphics that include midtones.

s 95/98/Me [Color Profile] in the [Advanced]dialog box displayed when you click 
[Advanced...], after selecting [Manual] from [Color] on the [Print/Qual-
ity] tab

s 2000/XP, Windows Server 2003 [Color Profile] on [Printer Features] on [Advanced...] on the [Pa-
per/Quality] tab in the Printing Preferences dialog box.

s NT 4.0 [Color Profile] on [Document Options] on the [Advanced] tab in the 
Document Defaults dialog box.

[Color Profile:] on [Printer Specific Options] in the print dialog box.

 X [Color Profile] on the [Features 2] tab on [Printer Features] in the print 
dialog box.
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[Auto
entation
this setting to enhance the reproduction of documents that contain text and graphics. This CRD
st for printing colored charts, graphs, presentation materials and so on. If you use this CRD for
ing photographs, the color or gradations might not be reproduced well.

 Color
this setting to print specific colors, logos and so on.

 Setting
this setting to print images with downloaded CRD from your application.

 Simulation
lates CLP.

this to select a color rendering dictionary (CRD). The CRD is referred to color matching, so you
ld select the appropriate CRD for the document you are printing. The selected CRD is also re-
d to when [Fine] or [Super Fine] is selected for “Color Setting”. The following items are available
],[Photographic], [Presentation] and [Solid Color].
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 to select the correction method used for color conversion.

owing table shows the tabs or menus where you can select this function.

ortant
u use Windows 95/98/Me, you can configure [Color Setting] in [Advanced] by selecting [Manual]
 the [Color] setting. [Automatic] sets the printer to “Super Fine”.

color rendering dictionary that is selected in the “Color Profile” setting is used.

 select the following items:

odification to the color setting.

s 95/98/Me [Color Setting] on the [Advanced]window displayed when clicking 
[Advanced...] after selecting [Manual] on [Color] on the [Print/Quality] 
tab

s 2000/XP, Windows Server 2003 [Color Setting] on [Printer Features] on [Advanced...] on the [Pa-
per/Quality] tab in the Printing Preferences dialog box.

s NT 4.0 [Color Setting] on [Document Options] on the [Advanced] tab in the 
Document Defaults dialog box.

[Color Setting:] on [Printer Specific Options] in the print dialog box.

 X [Color Setting] on the [Features 2] tab on [Printer Features] in the print 
dialog box.
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[Auto
ct this setting to perform color matching based on one of the printer's built- in color rendering
onaries and perform CMYK conversion. This setting performs the printing which output target
onitor γ = 1.8.

r Fine
ct this setting to use a color rendering dictionary as in the “Fine” setting but produce output that
ore vivid. Use this setting to emphasize light colors. This setting performs the printing which
ut target is Monitor γ = 2.2.

this to select a color rendering dictionary (CRD). The CRD is referred to color matching, so you
ld select the appropriate CRD for the document you are printing. The selected CRD is also re-
d to when [Fine] or [Super Fine] is selected for “Color Setting”. The following items are available
],[Photographic], [Presentation] and [Solid Color].
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Window

Window

Window
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 Simulation Profile

 simulate the color tone of the printing ink. You can select the printing ink from SWOP, Euro-
d JapanColor.

s 95/98/Me [CMYK Simulation Profile] in the [Advanced]dialog box displayed 
when you click [Advanced...], after selecting [Manual] from [Color] on 
the [Print/Quality] tab

s 2000/XP, Windows Server 2003 [CMYK Simulation Profile] on [Printer Features] on [Advanced...] on 
the [Paper/Quality] tab in the Printing Preferences dialog box.

s NT 4.0 [CMYK Simulation] on [Document Options] on the [Advanced] tab in 
the Document Defaults dialog box.

[CMYK Simulation:] on [Printer Specific Options] in the print dialog 
box.

 X [CMYK Simulation] on the [Features 3] tab on [Printer Features] in the 
print dialog box.
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 to set the Image Rendering mode.

owing table shows the tabs or menus where you can select this function.

ortant
 use Windows 95/98/Me, you can configure [Dithering] in [Advanced] by selecting [Manual] from
r] setting. [Automatic] sets the printer to “Auto”.

 select the following items:

this setting to configure the best dithering method automatically depending on the appearance
e document to be printed.

ographic
rms dithering using an appropriate pattern for photographs.

s 95/98/Me [Dithering] in the [Advanced]dialog box displayed when you click 
[Advanced...], after selecting [Manual] from [Color] on the [Print/Qual-
ity] tab

s 2000/XP, Windows Server 2003 [Dithering] on [Printer Features] on [Advanced...] on the [Paper/Quali-
ty] tab in the Printing Preferences dialog box.

s NT 4.0 [Dithering] on [Document Options] on the [Advanced] tab in the Doc-
ument Defaults dialog box.

[Dithering] on [Printer Specific Options] in the print dialog box.

 X [Dithering] on the [Features 2] tab on [Printer Features] in the print di-
alog box.
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Mac OS
rms dithering using an appropriate pattern for text.

 Setting
this setting to print images set in half tone in your application.

Reproduction

 to select the Black Color mode for text and line art.

owing table shows the tabs or menus where you can select this function.

 select the following items:

k by K
ct this setting to use a black toner.

k/Gray by K
k portions are printed in gray.

s 95/98/Me [Gray Reproduction] in [Advanced] by selecting [Manual] from the 
[Color] setting. [Automatic] sets the printer to “Pure Black Text”.

s 2000/XP, Windows Server 2003 [Gray Reproduction] on [Printer Features] on [Advanced...] on the [Pa-
per/Quality] tab in the Printing Preferences dialog box.

s NT 4.0 [Black Text/ Graphics] on [Document Options] on the [Advanced] tab 
in the Document Defaults dialog box.

[Black by K] on [Printer Specific Options] in the print dialog box.

 X [Black Text/Graphics] on the [Features 2] tab on [Printer Features] in 
the print dialog box.
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Mac OS
+K
ct this setting to use all toners.

 Over Print

hether or not to apply a black color over any other colors when printing.

owing table shows the tabs or menus where you can select this function.

s 95/98/Me [Black Over Print] in [Advanced] by selecting [Manual] from the 
[Color] setting.

s 2000/XP, Windows Server 2003 [Black Over Print] on [Printer Features] on [Advanced...] on the [Pa-
per/Quality] tab in the Printing Preferences dialog box.

s NT 4.0 [Black Over Print] on [Document Options] on the [Advanced] tab in the 
Document Defaults dialog box.

[Black Over Print:] on [Printer Specific Options] in the print dialog box.

 X [Black Over Print] on the [Features 2] tab on [Printer Features] in the 
print dialog box.
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 Saving

 function to reduce the amount of toner used when printing.

owing table shows the tabs or menus where you can select this function.

 Control

 to select whether or not you want the colors in the documents to be adjusted before printing so
printed page matches closer to the colors on the screen.

owing table shows the tabs or menus where you can select this function.

s 95/98/Me [Toner Saving] on the [Print Quality] tab.

s 2000/XP, Windows Server 2003 [Toner Saver] on [Printer Features] on [Advanced...] on the [Pa-
per/Quality] tab in the Printing Preferences dialog box.

s NT 4.0 [Toner Saver] on [Document Options] on the [Advanced] tab in the 
Document Defaults dialog box.

[Toner Saver:] on [Printer Specific Options] in the print dialog box.

 X [Toner Saving] on the [Features 1] tab on [Printer Features] in the print 
dialog box.

s 95/98/Me The [Print Quality] tab.

s 2000/XP, Windows Server 2003 [Graphic] on [Advanced] on the [Paper/Quality] tab in the Printing 
Preferences dialog box.

s NT 4.0 This function is not available.

[Print Color] on the [Color Matching] tab in the print dialog box.

 X This function is not available.
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Mac OS
 use Windows 2000/XP or Windows Server 2003, this function is called “Image Color Manage-
t”.

u use Windows NT 4.0, this function can not be configured.

u use Mac OS, this function is called “Color Matching”.

e Color Control
lay the Image Color Matching dialog box, click this button to specify exactly how you want the
rs on your screen adjusted before printing.

ode

 to set a user code for print logging.

user code using up to eight digits. A user code identifies a group of users and allows you to
e number of sheets printed under each code with SmartDeviceMonitor for Admin.

owing table shows the tabs or menus where you can select this function.

rence
ore information about using SmartDeviceMonitor for Admin, see Help.

s 95/98/Me [User Code] on the [Statistics] tab.

s 2000/XP, Windows Server 2003 [User Code] on the [Job Log] tab in the Printing Preferences dialog 
box.

s NT 4.0 [User Code] on the [Job Log] tab in the Document Defaults dialog box.

[User Code] on [Job Log] in the print dialog box.

 X This function is not available.
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tting Up Options” in the Client Reference or the Administrator Reference for the installation
 appropriate to your printing environment.

owing table shows the tabs or menus where you can select this function.

 2
ou can select the tray with the following menu for PAPER FEED UNIT Type 1000:
.21 “Paper Source”

lex Unit
ou can use the following function with AD460:
.14 “Duplex Printing”

s 95/98/Me [Options] on the [Accessories] tab.

s 2000/XP, Windows Server 2003 [Installable Options] on the [Device Setting] tab.

s NT 4.0 [Installable Options] on the [Device Setting] tab in the Document De-
faults dialog box.

For ethernet, [Chooser] on the Apple Menu. For USB, [Change Setup] 
from the [Printing] menu to open the Desktop printer

 X This function is not available.
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ou can use the following function with Hard Disk Drive Type 2600.
.13 “Collate”
.6 “Job Type”

Note
This function is for Windows 95/98/Me only.

l Memory
ou can use the following function with SDRAM Module (Memory Unit Type C) (64/128/256
B):

.13 “Collate”

ote
he optional Memory Unit of at least 192 MB must be installed on the printer.
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nter Utility for Mac

Printer Utility for Mac, you can download fonts, change the name of the printer and so on.

tion
cintosh and printer are connected by USB, you cannot use Printer Utility for Mac.

 Utility for Mac is included on the CD-ROM labeled “Printer Drivers and Utilities”.

 Utility for Mac requires Mac OS 8.1 or later. (Mac OS X Classic environment is supported.)

 Utility for Mac cannot use Mac OS X (native mode).

ling Printer Utility for Mac

ese steps to install Printer Utility for Mac on the machine.

he Mac OS.

 the CD-ROM into the CD-ROM drive.

D-ROM icon appears.

e-click the icon of hard disk to open it.

e-click the CD-ROM icon.

ntents of the CD-ROM appear.

e-click the [Mac OS] folder.

e-click the [PS Utility] folder on the CD-ROM, and then drag the [Printer Utility for Mac]
d then drop it into the Macintosh hard disk.

he CD-ROM icon and drop it into [Trash] to eject the CD-ROM.

 Utility for Mac is installed.
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owing instructions describe how to start Printer Utility for Mac.

ortant
re starting Printer Utility for Mac, confirm that the printer is selected with [Chooser] on the Apple
u.

ble-click the Printer Utility for Mac icon.

Printer Utility for Mac dialog box appears.

k [OK].
er Utility for Mac will take a few seconds to start.

eference
or more information, see “Printer Utility for Mac Functions”. 
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tility for Mac functions are described below.

menu
ownload PS Fonts...]
ownload fonts (PostScript Type 1) to the printer. See p.38 “Downloading PS Fonts”.

isplay Printer's Fonts...]
isplay and delete the fonts in printer memory and the printer's hard disk drive. See p.39 “Dis-
laying Printer's Fonts”.

nitialize Printer's Disk...]
itialize the printer's hard disk drive. See p.41 “Initializing the Printer Disk”.

age Setup...]
et up the paper size to print “Printer Font Catalog” and “Printer Font Sample”. See p.41 “Page
etup”.

rint Font Catalog...]
rint the names of available fonts. See p.42 “Printing Font Catalog”.

rint Font Sample...]
rint a sample of fonts. See p.42 “Printing Font Sample”.

ename Printer...]
hange the printer's name when viewed via Appletalk. See p.42 “Renaming the Printer”.

estart Printer]
estart the printer. See p.43 “Restarting the Printer”.
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ownload PostScript File...]
ownload a PostScript File. See p.44 “Downloading PostScript Files”.

elect Zone...]
hange the zone to which the printer belongs to via Appletalk. See p.44 “Selecting the Zone”.

isplay Printer Status...]
isplay the status of the printer. See p.45 “Displaying the Printer Status”.

aunch Dialogue Console...]
reate and edit a PostScript file, and then download it to the printer. See p.46 “Launching the
ialogue Console”.

loading PS Fonts

 download the PS fonts to the printer's memory or hard disk drive.

ortant
following procedures to download the fonts assume that you are a system administrator. If you
ot, be sure to consult your system administrator.

 printer restarts, all the printer settings return to their defaults.

irm that a Mac OS and the printer are connected with Appletalk.

e fonts cannot be downloaded.

re downloading, read the documentation about the fonts you want to use.

ct [Download PS Fonts...] on the [File] menu.

k [Add to list].
dialog box to select fonts appears.
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k to select the desired font files, and then click [Open].
list of selectable font names appears.

r adding all the fonts you want to download, click [OK].
dialog box of selected fonts to download appears.

k [Download].
fonts begin to download, and the download status is shown.

portant
uring the download, do not turn off the power switch, operate the panel or open or close the
over.

n the completion message appears, click [OK].

k [Cancel].

ying Printer's Fonts

 display the available fonts currently downloaded to the printer. Fonts in the printer's memory
 disk drive can be displayed.

fonts displayed in italics are the default fonts.

ct [Display Printer's Fonts...] on the [File] menu.

alog box appears.

ct [Printer's memory] or [Printer's disk].

k [OK].
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 delete fonts from the printer's memory or hard disk drive.

ct [Display Printer's fonts] on the [File] menu.

alog box appears.

ct [Printer's memory] or [Printer's disk].

ct the fonts you want to delete.

imitation
ou cannot delete the fonts displayed in italic.

k [Delete].
nfirmation message appears.

firm the fonts you want to delete and the printer name from which you want to delete the
s.

k [Continue], and then click [OK].

k [OK].
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itializing the printer's hard disk, all the fonts downloaded to the printer's hard disk drive are
 Before initializing, be sure to check the fonts on the hard disk drive.

ortant
n initializing the printer's hard disk drive from the operation panel, all of the data on the printer's
 disk drive is deleted. Before initializing, be sure to check the data on the hard disk drive.

ct [Initialize Printer's Disk...] on the [File] menu.

confirmation message appears.

ote
o cancel initialization, click [Cancel].

k [Execute].
lizing starts.

portant
o not turn off the power switch until initializing is completed, otherwise the hard disk drive migh
e damaged.

n the completion message appears, click [OK].

Setup

 set the paper size on which to print “Print Fonts Catalogue” and “Prints Fonts Sample”.

ct [Page Setup...] on the [File] menu.

ose the paper size.
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ng Font Catalog

 names of fonts available on the printer.

paper selected under [Page Setup] is used.

ct [Print Fonts Catalogue] on the [File] menu.

k [Print].

ng Font Sample

 print samples of fonts downloaded to the hard disk drive or memory.

 by using the paper selected on [Page Setup].

ct [Print Fonts Sample...] on the [File] menu.

k [Print].

ing the Printer

 change the printer's name displayed under Appletalk. If you connect several printers on the
, assign different names so you can identify them. If several printers have the same name, a digit
 next to the printer name in [Chooser].

ct [Rename Printer...] on the [File] menu.

e a new name in the [New Name:] field. 
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ou can enter up to 31 digits and letters.

o not use symbols, for example “*”, “:”, “=”,”@”, “~”.

k [Rename].
printer name is changed.

s [OK].

ct [Chooser] on the Apple menu.

k the [AdobePS] icon.

k to select the printer name renamed in step B, and then close [Chooser].

ote
 there are several Appletalk zones, select the zone to which the printer belongs to.

rting the Printer

 restart the printer.

ct [Restart Printer] on the [File] menu.

firm the message that appears on the screen, and then click [Restart].
printer restarts.

ote
he fonts that you downloaded in the printer's memory will be deleted.

 the printer restarts, all the printer settings return to their defaults.
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loading PostScript Files

 download a Postscript file to the printer.

ct [Download PostScript File...] on the [Utility] menu.

ct the file name to download and click the file name, and then click [Open].

e the log file name, and then click [Save].
selected file is downloaded.

ote
rrors are recorded in the log file.

ting the Zone

 change the zone to which the printer belongs to via Appletalk.

ortant
irm that the printer and a Mac OS are connected in an Appletalk environment.

ct [Select Zone...] on the [Utility] menu.

zone to which the printer belongs to and the available zone list appear.

ct the zone to which you want to switch the printer, and then click [Change].
nfirmation message appears.

k [Continue].
nfirmation message appears.

s [OK].
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ct [Chooser] on the Apple menu.

k the [AdobePS] icon.

ct the zone selected in step B on the [Appletalk zone:] list.

k to select the printer you want to use on the [Select a PostScript Printer:] list.

e [Chooser].

ying the Printer Status

 display and confirm the current status of the printer.

ct [Display Printer Status...] on the [Utility] menu.

current status of the printer appears.

firm the current status of the printer.

 can confirm the memory capacity, the VM (Virtual Memory) space, the hard disk drive status
available space on the hard disk drive. You can also confirm the zone to which the printer be-
s to.

k [OK].
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 create and edit a PostScript file for printing, and then download it to the printer.

ortant
nch Dialogue Console” is recommended for users with an understanding of PostScript.

ot download any file other than PostScript files to the printer.

nch Dialogue Console” must be used at your own responsibility.

ct [Launch Dialogue Console...] on the [Utility] menu.

 the editing screen. The Dialogue Console menu bar appears.

e the PostScript command in the editor screen.

ote
o edit a PostScript file, select [Open] on the [File] menu to open it.

ou can search or replace a character string by using the [Search] menu.

r editing the PostScript file, select [Download Top Window] on [Console] menu to start print-

PostScript file is sent to the printer.

ote
he [Reply from Printer] box opens, depending on the PostScript file you sent.

ct [Return To Main Menu] on the [Console] menu to close the PostScript file.
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